
MacCribbage Quick Start
Welcome to MacCribbage.  If you already know how to play Cribbage, this 
section will quickly describe how to play against your Mac using 
MacCribbage.  Read the following sections for a more detailed description 
of how to play Cribbage with MacCribbage.

•  Throw two cards to the crib by clicking on them and clicking the Send To
Crib button
•  If you dealt, click the deck to turn over the starter
•  Play cards by either double-clicking them or dragging them onto the 
playing field
•  If you chose Manual Pegging you will have to peg your points when you 
score -- first click on the back peg, then click on the hole where you want 
the peg placed
•  If you have to say Go click the Go button
•  If you score points and don't know why, click and hold the Pegging Help 
icon:  .
•  After the hand is over you score the cards in your hand including the 
starter and click the OK button
•  Continue until a player scores enough to win the game and begin again



MacCribbage
Cribbage is played with a standard deck of 52 cards.  The object of the 
game is to score enough point to win a game (usually 121 points).  Keeping 
score on paper is unwieldy because points are scored throughout the hand,
not just at the end.  For this reason a peg board is usually used to keep 
score.  Each player has two pegs, a front peg to mark the current score, 
and a back peg that is picked up and moved ahead when the player scores 
more points.

The players alternate dealing hands until a player scores enough to win a 
game, at which time play stops, all scores are reset to zero, and a new 
hand is dealt.  A hand is divided into three phases, Cribbing, the Play, and 
the Show, which will be described below.



Scoring Combinations
Players can score points throughout the Play and Show phase of each hand.
Points are scored by grouping cards into various scoring combinations.  
Before we describe how each hand is played we will present all the scoring 
combination up front.  The scoring combinations are as follows:

Fifteens
Any combination of cards whose pips add up to fifteen scores two points 
(the Jack, Queen, and King each have ten pips while the Ace has one pip).  
For example the cards 7H, 7S, 8C can be grouped 7H-8C and 7S-8C 
scoring four points.  Note that the 8C was used in both groups!  The 
definition of a fifteen is any combination of cards that add up to fifteen.  
Thus a particular card can be used in many different scoring groups.

Pairs
Any two cards with the same face value score two points.  Note that a Jack 
and Queen do not form a pair.  For example the cards 6H, 6C, JS, JD can be 
grouped 6H-6C and JS-JD scoring four points.  Another example, the cards 
7H, 7D, 7S can be grouped 7H-7D, 7H-7S, and 7D-7S scoring six points!  
Again, a particular card can be used in many different scoring groups (by 
the way, a four of a kind would score 12 points from pairs)!

Runs
Any combination of three or more cards whose face values are successive 
from a run.  One point is given for each card in the run.  Note that the Ace 
can only be in a run with a two and three, not a Queen and King.  

Examples:
The cards AC, 2H, and 3D group together to score three points.
The cards AC, 2H, 2S, and 3D can be grouped  AC-2H-3D and AC-2S-3D to 
score six points.  (Note these four cards are actually worth eight points 
because of the two points for the pair of twos.)

Note that in the case of runs, every card that can be in a run must be put 
there, thus the cards AC, 2H, 3D, and 4H are one run of four cards yielding
four points.  You cannot score this as two runs of three cards!

Flush
If all four of the cards you keep have the same suit you will be able to score
a Flush during the Show phase.  One point is given for each card in the 
flush.  

Examples:
The cards AH, 5H, 7H and 10H group together to score four points.



Note that as in the case of runs, every card that can be in a flush must be 
put there, thus the cards AH, 5H, 7H, 9H and 10H are one flush of five 
cards yielding five points.  You cannot score this as two flushes of four 
cards!

Flushes cannot be scored during the Play phase and there are special rules
for scoring flushes during the Show phase.  See description of the Show 
phase below.



His Heels and His Nobs
There are two special scoring opportunities for Jacks.  His Heels scores two
points and can be scored only during the Play phase while His Nobs scores 
one point and can only be scored during the Show phase.  See description 
of the Play phase and Show phase below.



Pegging
The peg board on the right side of the MacCribbage window shows the 
current score of the hand.  The score can be read by looking at the position
of each player's front peg.  On a color monitor your pegs are on the blue 
track and the Mac's are on the Red track.  On a black and white monitor 
your pegs are on the white track and the Mac's are on the gray track.

When you score points throughout the hand you have to option of whether 
to peg you score manually or automatically.  You make this choice on the 
Pegging menu.  

If you choose Automatic Pegging, your pegs will be moved automatically 
whenever you score.  When your score has been pegged click either the 
Done Pegging or Continue button, whichever is hilited.  If you have Quick 
Peg on under the Pegging menu the back peg will immediately move to its 
proper position.  If Quick Peg is off the back peg will move one hole at a 
time until it reaches its proper position.

If you choose Manual Pegging, you will move your pegs yourself.  When you
score the pointer will change from an arrow to a hand.  Click on your back 
peg between the thumb and forefinger of the hand.  The pointer will 
change into a peg.  Click the tip of the peg onto the hole where you want to
place the peg.  You do not have to place the peg directly into its proper 
position.  You may make many smaller jumps.  This comes in handy when 
scoring your hand as do not have to keep track all the different kinds of 
scoring combinations in you head.  When your score has been pegged click 
either the Done Pegging or Continue button, whichever is hilited.  

Players should take advantage of MacCribbage's Pegging Help system.  When
you have points to score, the Pegging Help icon, , will appear above 
your cartoon balloon on the playing field.  Click and hold on this icon and 
the Pegging Help window will appear describing the breakdown of the 
points you have earned.  This should help novice players get to know the 
sometimes complicated scoring system of Cribbage.



The Cribbing Phase
At the start of each hand six cards are dealt face down to each player.  The 
players must select two of those cards to throw away.  The four cards that 
are thrown away are placed together and are called the Crib.  The Crib is 
placed next to the dealer and will be used to score points for the dealer 
during the Show phase.  During the Cribbing Phase the playing field shows 
which player will get the Crib for this hand. 

To choose a card to throw to the Crib click on it and it will hilite.  If you 
change you mind about a card, click on it again.  When you have selected 
your two cards, click the Send To Crib button.

The Cribbing phase is the most strategically important part of each hand 
because it is here that you decide which cards you will be able to make 
scoring combinations with during the Show phase where most of the points
in each hand are scored.  When selecting which cards to throw you should 
determine which four cards will yield the highest number of points using 
the scoring combinations described above.  

Remember that the dealer will not only be able to their hand during the 
Show phase, but also the four cards that make up the Crib.  Thus, when the
Crib goes to the Mac you should be careful to not throw cards that will lead
to point for the Mac (i.e., a pair) unless it makes sense for the cards you 
are keeping.  On the other hand, when the Crib is going to you, you have 
much greater flexibility in the cards you select because you will be able to 
use the cards you throw during the Show phase when you get to score 
points with the Crib.



The Play Phase
When both players have thrown their cards to the crib the Play phase 
begins with the dealer tuning over the top card of the deck and placing it 
face up.  You do this by clicking on the deck.  This card is called the starter.
If the starter is a Jack the dealer immediately pegs 2 points.  This is called 
His Heels.

Play then begins with the non-dealer playing a card.  You do this by either 
double-clicking the card or dragging it onto the play field.  When a card is 
played the total of pipes of all the cards on the table is announced by the 
player.  This total is shown in the cartoon balloons on the playing field.  The
other player then plays a card.  This continues until on a player's turn they 
cannot play a card without taking the pip total over 31.  When this happens
the player must say "Go."  You do this by clicking the Go button on the 
playing filed.  When a player says Go the other player must play any cards 
that they can without taking to total over 31, and then score one point for 
forcing the other player to say Go.  Also, there is a one point bonus for 
making the total 31 exactly.  Thus when a player makes the pip total 31 they
will score one point for forcing Go and another 1 point bonus.  After a Go, 
all the cards are cleared from the playing field and the player who said Go 
leads by playing another card.  This continues until both players have no 
cards.  When a player runs out of cards they must say Go since they cannot
play a card.

Besides the points for Go and 31, points can be scored by making scoring 
combinations of the played cards.

Fifteen
When a player makes the pip total equal 15, that player scores two points.  
Thus, it's usually not a good idea to lead with a 5 since there are so many 
cards with ten pips in the deck.

Pairs
When a player makes a pair with the most recently played card or cards, 
that player scores two points for each pair.  For example, if you lead with 
8H, the Mac plays 9C, and then you play 9S you score two points for the 
pair.  If the Mac then plays 9D, the Mac scores 6 points for the three pairs 
of 9s.  Note that to be a pair the cards must be played consecutively.

Runs
When a player makes a run with the most recently played cards, that 
player scores on point for each card in the run.  For example, if you lead 
with 5C, the Mac plays 7D, and then you play 6H you score three points for
the run.  If the Mac then plays 4H, the Mac scores four points for the run.  



NOTE:  During the Play phase only the most recently played cards can 
count for a run.  Thus the sequence 5C, 4H, 4D, 6S does not count as a run 
since the most recently played three cards are 4, 4, 6 and do not form a 
run.

Flushes cannot be scored during the Play phase.

If you are using Manual Pegging, when you score points during the Play 
phase the Pegging Help icon will appear.  Use this system to help you to 
learn about scoring opportunities during the Play phase.



The Show Phase
When both players have played all four of their cards the Show phase 
begins.  First, the non-dealer places all four of their cards face up on the 
playing field.  The non-dealer then uses those four cards along with the Starter
to make as many scoring combinations as possible.  After the non-dealer 
has scored, the dealer turns up their own hand of four cards and along with
the starter scores all the points they can.  The dealer then turns up the Crib
and does the same with it.

The scoring combinations during the Show phase are as follows:

Fifteens
Any combination of cards that add up to fifteen scores two points.

Pairs
Any two cards with the same face value score two points.

Runs
Any combination of three or more cards whose face values are successive 
from a run.  One point is given for each card in the run.

Flush
To score a flush with the dealer's or non-dealer's own hand all four of their 
own cards must have the same suite.  This will score four points.  If the 
Starter's suit is also the same the flush will be worth five points.  To score a
flush with the Crib, all four cards of the Crib and the Starter must have the 
same suit.  This will score five points.

His Nobs
In any of the three hands, if the hand has the Jack of the same suit as the 
Starter, this is called His Nobs and scores one point (this one is EASY to 
forget)!

While the Mac will always count all of its points, a player my forget or miss 
scoring combinations contained in a hand.  If the Muggins option on the 
Pegging menu is on, the Mac will steal all the points that you missed!  
Novice players should turn Muggins off until they get used to the scoring 
system.

Remember to use the Pegging Help system during the Show phase.  This 
will help you to learn to score you hands without missing points.



By the way, the highest possible score for the four cards of and hand and 
the starter during the Show phase is 29.  Can you think of a hand that 
makes 29?



Winning a Game
You set the length of a game by choosing the Game Length command on 
the Options menu.  The standard length for each game is 121 points.  The 
game immediately ends when a player pegs the whatever score is set as 
the game length.  Thus, as the score gets close to the end, it is important to
note who is dealing since the non-dealer get to peg his points during the 
Show phase first.  When the game ends, the Statistics window will be 
displayed, showing statistics about the game that just ended.  To start the 
next game, either close the Statistics window or click on the MacCribbage 
window.  See below for more information about the Statistics window.

The Game Length dialog box also contains the Lurch settings.  You score a 
lurch by winning a game before you opponent reaches a certain score.  By 
default, when the game length is set for 121 points, you will win two games
if win before your opponent reaches 91 points, and you will win three 
games if you win before your opponent reaches 61 points.

The number of games won by each opponent in the current match is shown
at the bottom of the peg board.  There are two numbers for each player.  
The first number is the number of games won including lurches.  The 
second number is the number of "natural" games won.



Saving Matches
MacCribbage allows you to keep track of a series of games called a Match. 
You can save a game in progress at any time by using the Save command 
on the File menu.  To resume the game, double-click the file from the 
Finder.  The match file keeps track of all the games that have been played 
in the match thus far along with many statistics.

The "artificial intelligence" of MacCribbage uses a very simple set of rules, 
yet it is quite effective.  I hope that even a good player will be able to win 
no more than 60% of the games in a match.  Maybe you will do better :--)



Customizing MacCribbage
MacCribbage has a number of customizing options to suit the way you 
would like to play.  All the following options are saved when you save a 
Match.

Peg Board
The Board menu allows you to choose among four different peg board 
styles:  Standard N (like the MacCribbage icon), Traditional, Snake, and 
Spiral.

Voice
The Voice menu allows you to choose a voice the Mac will use while calling 
out the total pips during the Play phase.  The Mac will even say Go!  This 
makes playing against the Mac more realistic.  The choices are Male 
(Mike) and Female (Shari).  (Yep, that us!)

Table Color
On the Options menu, the Table Color command shows a hierarchical menu
of colors and shadings.  These control the color of the playing field.  The 
default is 50% green.

Statistics
The Statistics command on the Windows menu shows the Statistics 
window.  This shows a variety of interesting statistics about the match and 
game in progress.  The top of the window shows the score of the current 
game.  The left part of the window refers to the current game, and the 
right side of the window refers to the entire match.  The graphs show the 
number of points each player scored per hand during the Play and Show 
phases.  The bottom of the window shows the total points scored by each 
player during the Play and Show phases.

Menu Command Reference
The following is a reference of all the menu commands in MacCribbage.

Apple Menu
About MacCribbage

Displays information about MacCribbage such as version number and 
shareware agreement.

File Menu
New Match

Starts a new match.



Open
Opens a Match file that was previously saved.

Close
Closes the Statistics window if it is the front window.

Save



Saves the current match.  If it was not previously saved, you are 
prompted for the file's name.

Save As
Saves the current match to a new file.

Quit
Quits MacCribbage.

Edit Menu
The Edit menu is not used in MacCribbage.

Options Menu
Game Length

Allows you to set the length of a game as well as options for Lurches.

Table Color
Allows you to set the color and shading of the playing field.

Pegging Menu
Automatic Pegging

When this option is checked, your points will be pegged for you 
automatically.

Manual Pegging
When this option is checked, you must peg you own points by clicking 
you back peg and then clicking on where you want the peg placed.

Muggins
When this option is checked, any points you miss during the Show phase 
will be stolen by the Mac.

Quick Peg
When this option is checked, pegs will automatically jump to there 
correct position.  If it is not check, pegs will advance one hole at a time.

Board Menu
This menu allows you to choose which peg board you want to use.

Voice Menu
No Voice

When this option is checked, no voice will be used by the Mac.

Female Voice (Shari)



When this option is checked, the Mac will use a female voice when 
calling out the total pips during the Play phase.

Male Voice (Mike)
When this option is checked, the Mac will use a male voice when calling 
out the total pips during the Play phase.



Window Menus
Cribbage

This command brings the Cribbage Window to the front.

Statistics
This command brings the Statistics Window to the front.

Shareware Agreement
InterStellar MacCribbage is published as Shareware.  The shareware 
concept is to produce high quality software at a low price by avoiding 
overhead like packaging, marketing and sales.  The shareware fee for 
MacCribbage is $10.  We hope that if you like MacCribbage and keep it you
will send in the shareware fee.  This will allow us to spend time improving 
MacCribbage and producing more quality software.

Please make checks payable to Michael Houser.  You can fill out the 
MacCribbage Registration form included with the MacCribbage package, 
or simply send $10 along with your name, address, e-mail address, the 
name of the game you are registering, the version number, and how you 
originally got the MacCribbage package to:

Michael Houser
5680 Foster Road
Bainbridge Island, WA  98110

You are allowed to give MacCribbage away to anyone you like as long is 
you also include all the files that came with the package.

About InterStellar Software
InterStellar Software is Michael and Shari Houser.  We began publishing 
shareware with the initial release of MacCribbage in July 1990.  Our other 
products are the solitaire games Egyptian Solitaire and Monte Carlo 
Solitaire.

To obtain the latest versions of our product you can view our World-Wide-
Web site at http://www.wolfenet.com/~houser/InterStellar/home.html.  

Any questions, comments or bug reports are welcome through our e-mail 
address, houser@wolfenet.com, or our U.S. mail address,  5680 Foster 
Road, Bainbridge Island, WA 98110.

The Housers reside on Bainbridge Island, Washington.  Michael is a 
software engineer for Adobe Systems and Shari is the full-time mother of 
our new little girl, Casandra.



We hope that you enjoy MacCribbage, try our other products and tell your 
friends about them.

Michael and Shari Houser - 2/4/95
houser@wolfenet.com


